Installation Guide for Modeling Tools for SAP BW/4HANA and SAP BW powered by SAP HANA
SAP BW Modeling Tools 1.18
1 Introduction.............................................................................................................. 3
2 Preparation.................................................................................................................. 4
  2.1 Implementing Corrections for AS ABAP 7.4 SP5.................................................. 4
  2.2 Implementing Corrections for BW Modeling Tools............................................ 4
  2.3 Installation Requirements.................................................................................. 5
  2.4 Establishing Secure Network Communication.................................................... 6
  2.5 Configuring Profile Parameters for Assertion.................................................... 7
  2.6 Configuring the BW Web Service......................................................................... 7
  2.7 Assigning Roles and User Authorizations......................................................... 8
  2.8 Downloading Required Packages from SAP Service Marketplace.................... 10
3 Installation.................................................................................................................. 11
  3.1 Installing ABAP Development Tools................................................................. 11
    - Prerequisites........................................................................................................ 11
    - Context............................................................................................................... 13
    - Installation Steps............................................................................................... 13
    - Result................................................................................................................. 18
  3.2 Installing BW Modeling Tools............................................................................. 18
  3.3 Updating BW Modeling Tools............................................................................. 22
  3.4 Recommendations for the System Administrator............................................... 23
4 Post-Installation.......................................................................................................... 24
  4.1 Configuring Eclipse Runtime Options.................................................................. 24
5 Additional Information............................................................................................... 26
  5.1 Uninstalling BW Development Tools................................................................. 26
  5.2 Updating BW Modeling Tools............................................................................. 27
  5.3 Getting Support Information............................................................................... 29
6 Support and Maintenance Strategy.......................................................................... 30
  6.1 Server............................................................................................................... 30
  6.2 Client.................................................................................................................. 30
1 Introduction


Their main objective is to support BW model developers working in the increasingly complex BI environments by providing them with state-of-the-art modeling tools. These tools include integration with SAP HANA modeling and consumption of SAP HANA elements in BW Open ODS Views or CompositeProviders, with powerful UI (user interface) capabilities.

This documentation describes how to install and distribute front-end components of BW Modeling Tools on your local drive. It also includes sections explaining how to prepare the relevant BW back-end systems to work with BW Modeling Tools.

This version of the installation guide applies to the following back-end system versions:

- SAP BW/4HANA 1.0 Support Package Stack 04 or a higher Support Package Stack
- SAP Business Planning and Consolidation, version for SAP BW/4HANA, 11.0 Support Package Stack 00, on top of SAP BW/4HANA 1.0 Support Package Stack 04
- SAP Business Warehouse 7.5 Support Package Stack 08 or a higher Support Package Stack
- SAP Business Warehouse 7.4 Support Package Stack 05 or a higher Support Package Stack

The availability of the BW Modeling Tools features is dependent on the BW back-end system version. The complete set of BW Modeling Tools features is only available when using the latest BW back-end system release.

The BW Modeling Tools client is downward compatible. This means that it can operate with an older BW back-end system version.
2 Preparation

The preparation prior to the installation of front end components includes all steps that you need to perform, in order to ensure that your work with BW Modeling Tools runs smoothly.

The preparation includes completing the following activities for each BW application server you want to work with:

1. Implementing corrections for ABAP Development Tools
2. Implementing corrections for BW Modeling Tools
3. Installation requirements
4. Establishing secure network communication
5. Configuring profile parameters for assertion tickets
6. Configuring BW Web services
7. Downloading required packages from SAP Marketplace

2.1 Implementing Corrections for AS ABAP 7.4 SP5

The BW Modeling Tools use framework features of the ABAP Development Tools.

Therefore, you must ensure that the minimum required support package is applied and the corresponding corrections are implemented. In general, AS ABAP of SAP NetWeaver 7.4 SP5 or higher is required as the server component.

For information on preparing the AS ABAP, consult the ADT installation guide and see SAP Note 1777849.

Note

For some features, like designing a query with the BW Modeling Tools, you need to install 7.4 SP9 or higher.

2.2 Implementing Corrections for BW Modeling Tools

Check for mandatory corrections that must be applied on the ABAP back end system.

Before you can start with the installation of the BW Modeling Tools, check SAP note 1905207 for mandatory corrections, which must be applied on the AS ABAP. Furthermore, there you can find general maintenance hints regarding the BW Modeling Tools (SAP Component BW-MT).
2.3 Installation Requirements

To install the BW Modeling Tools, you need to have one of the following components installed.

- One of the following Operating System (OS) has to be installed on your local PC:
  - Windows 7
  - Windows 8
  - Windows 10
  - Apple Mac OS X 10.8 or higher
  - Linux distribution: supported in SAP environments

- Internet Explorer >= 7.0 or Firefox >= 4.0 has to be installed on your local drive.

- For Windows OS, SAP GUI for Windows 7.3 or SAP GUI for Windows 7.4 has to be installed on your local drive. If this is not already installed, please install the SAP GUI from the SAP Software Download Center on the SAP Service Marketplace. You will need this SAP GUI to integrate GUI-based tools in the new BW IDE.

- Microsoft Runtime DLLs VS2010 (for Windows OS) is installed on your local drive. You need this component to communicate with the back-end system.

  **Note**
  - If you are using SAP GUI for Windows, the 32 bit version of this runtime component will already be installed on your local machine.
  - If you are using a 64 bit version of Eclipse, you need to install this runtime component separately from the Microsoft installation page.
  - If you start BW Modeling Tools before you have installed the DLLs, an error dialog might appear stating that the ABAP communication layer is configured incorrectly. In this case, you need to restart Eclipse with the "-clean" option. Afterwards, remove the "-clean" option again. For further information, see The Eclipse runtime options.

- To install, you have the following two options:
  - working on SAP HANA Studio: For this use case, you need to have the suitable SAP HANA Studio (32 bit or 64 bit for Windows) installed. Due to dependencies on Eclipse 4.5 (alias Mars edition) and Eclipse 4.6 (alias Neon edition), it is necessary to use version SAP HANA Studio SP11 or higher. You can find installation details in the corresponding SAP HANA Studio installation guide.
  - working on Eclipse: For this use case, you need to have the suitable Eclipse Package installed. We recommend to install Eclipse 4.6 (alias Neon edition).

If you have a Microsoft Windows platform, we recommend not to install the SAP HANA Studio or the Eclipse Package into a Windows standard folder like the Windows "Program Files" folder. Due to permission restrictions, we cannot ensure that the tools will work with all features.

2.4 Establishing Secure Network Communication

In BW Modeling Tools, model developers always work with BW projects to access repository objects from back-end systems.

Context

A BW project represents a real system connection on the front-end client and therefore requires an authorized user to access the back-end system. With the standard authentication method, the user enters his or her user ID and password on the front-end client to log on to the back-end system. For security reasons however, you must ensure that Secure Network Communication (SNC) is enabled for the selected system connection.

Tip

For the sake of convenience and for increased security, also use the single sign-on (SSO) option for system authentication (if available in your system landscape). Compared with SNC, SSO provides extra security when working with BW projects. Using SSO, the user does not need to enter a user ID and password, but can access the specific system directly once the system has checked the validity of the logon ticket.

Note that the setup of SSO represents a general configuration step. This is identical for the ABAP development tools. If the environment has already been prepared for SSO in the context of the ABAP development tools, no further configurations are therefore required.

Table 1: Establishing Secure Network Communication

<table>
<thead>
<tr>
<th>Task</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable SNC for an BW system.</td>
<td>1. Add the relevant BW system to the SAP Logon Pad (if not already done).</td>
</tr>
<tr>
<td></td>
<td>2. In the SAP Logon Pad, open the Properties page for the BW system.</td>
</tr>
<tr>
<td></td>
<td>3. Enable Secure Network Communication for the selected system (if not already done).</td>
</tr>
<tr>
<td>Enable SSO for an BW system.</td>
<td>1. Install the SAP NetWeaver Single Sign-On 1.0 SP03 or higher (either “Secure LoginClient” or “Enterprise Single Sign-On”) for the corresponding platform (either for 32- or 64-Bit).</td>
</tr>
</tbody>
</table>
2.5 Configuring Profile Parameters for Assertion

In addition to logon tickets, AS ABAP systems can also issue more restricted assertion tickets when accessing system services.

Context

Assertion tickets can help to provide increased security when using the integrated SAP GUI in BW Development Tools. Instead of prompting for the password, the back-end system checks the validity of the assertion ticket before allowing the user access to system services.

Procedure

Use the following settings to configure your AS ABAP system in such a way that it issues assertion tickets only (without logon):

Table 2: Profile Parameters for Assertion

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>login/create_sso2_ticket</td>
<td>3</td>
<td>The parameter with this value causes the ABAP system to issue assertion tickets.</td>
</tr>
<tr>
<td>login/accept_sso2_ticket</td>
<td>1</td>
<td>The parameter with this value configures the ABAP system to accept assertion tickets.</td>
</tr>
</tbody>
</table>

2.6 Configuring the BW Web Service

In order for users to be able to use the data preview feature in the BW Modeling Tools, the BW Web Services must be active and accessible by HTTPS.

Note

For information about how to configure this service, read the SAP NetWeaver installation guide. For further details, see SAP Note [517484](https://www.sap.com) (Business Information Warehouse section).

For usage of the data preview in the BW Modeling Tools it is required to activate the following service in the SICF transaction: `/default_host/sap/bc/webdynpro/sap/fpm_bics_ovp`. 
2.7 Assigning Roles and User Authorizations

The assignment of authorizations to back end system users is based on roles that are predefined in the SAP BW system. As a system administrator, you assign one or more roles to back end system users. From a technical viewpoint, these roles are based on authorization objects.

The following configuration steps include some of the same authorization objects mentioned in the installation guide of the ABAP Development Tools. Some of the authorization objects might therefore already be configured.

**Standard Role** SAP_BC_DWB_WBDISPLAY

The following role is required to use the BW Modeling Tools. If role SAP_BC_DWB_ABAPDEVELOPER is already assigned to a user, it includes the required authorization, which means the following role does not need to be assigned.

Table 3: Standard Role

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP_BC_DWB_WBDISPLAY</td>
<td>Role that contains all authorizations to display and browse ABAP development objects.</td>
</tr>
</tbody>
</table>

**Note**

The users are not allowed to modify ABAP development objects.

**Authorization object** S_RFC

The BW Modeling Tools requires remote access to the following function modules that are specified for authorization object S_RFC:

Table 4: Authorization object S_RFC

<table>
<thead>
<tr>
<th>Activity [ACTVT]</th>
<th>RFC Object Name [RFC_NAME]</th>
<th>RFC Type [RFC_TYPE]</th>
</tr>
</thead>
<tbody>
<tr>
<td>16 (Execute)</td>
<td>DDIF_FIELDINFO_GET</td>
<td>FUNC (Function Module)</td>
</tr>
<tr>
<td></td>
<td>RFCPING</td>
<td></td>
</tr>
<tr>
<td></td>
<td>RFC_GET_FUNCTION_INTERFACE</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SADT_REST_RFC_ENDPOINT</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SUSR_USER_CHANGE_PASSWORD_RFC</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SYSTEM_RESET_RFC_SERVER</td>
<td></td>
</tr>
</tbody>
</table>
**Authorization object S_TCODE**

The BW Modeling Tools have to start specific transactions in order to enable SAP GUI integration in Eclipse. This means that the tools require access to the following transaction codes specified in authorization object S_TCODE:

- SADT_START_TCODE
- SADT_START_WB_URI

**Authorization object S_ADT_RES**

The BW Modeling Tools use the following URI prefix for authorization object S_ADT_RES:

<table>
<thead>
<tr>
<th>Field name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>URI</td>
<td>/sap/bw/modeling/*</td>
</tr>
</tbody>
</table>

**Note**

The wildcard “*” is used for the subpaths of the URI.

**New BW authorization objects in 7.4 SP5**

In order for users to use the BW Modeling Tools editors, the following authorization objects must be configured:

- S_RS_HCPR: for creating and maintaining CompositeProviders.
- S_RS_ODSV: for creating and maintaining Open ODS views.

**New BW authorization object in 7.4 SP8**

In order for users to use the BW Modeling Tools editors, the following authorization object must be configured:

- S_RS_ADSO: for creating and maintaining advanced DSOs.
2.8 Downloading Required Packages from SAP Service Marketplace

Download the packages for the ABAP Development Tools for SAP NetWeaver and for the Modeling Tools for SAP BW powered by SAP HANA from the SAP Service Marketplace (SAP SMP).

Prerequisites

Before you can download packages from the SAP SMP you need an S User. In general it is not necessary for each BW model developer to have an S User account. The packages will normally be downloaded by one person and then shared with the corresponding BW model developers.

Context

The ABAP Development Tools represents a mandatory component for the BW Modeling Tools due to the consumption of the communication framework.

Note

Check SAP note 1905207 for information about suitable versions.

The first step is to download the required components from the SAP Service Marketplace.

Procedure

2. Search for the SAP ABAP in Eclipse installation package and add it to the download basket.
3. Search for the SAP BW Modeling Tools installation package and add it to the download basket.
4. Download the corresponding archive files (zip) and unpack them to a local directory of your choice. In this guide, the following directories will be used:
   - ABAP Development Tools: c:\MyDownloads\ABAP_Dev_Tools
   - BW Modeling Tools: c:\MyDownloads\BW_Modeling_Tools

Note

The folder structure for these is identical to typical Eclipse update sites which can be accessed via HTTP.
3 Installation

The following installation procedure comprises all front-end components that are required in order to run the BW Modeling Environment on your local drive.

The description of the installation and update procedures is geared particularly toward you as a system administrator on the SAP customer side and provides you with a central reference installation. After this, SAP provides a number of recommendations, so that you can make the installation of the BW Modeling Tools available to all the BW model developers within your organization.

Related Information

Installing BW Modeling Tools [page 18]
Updating BW Modeling Tools [page 22]
Recommendations for the System Administrator [page 23]

3.1 Installing ABAP Development Tools

3.1.1 Prerequisites

Operating System

The following operating system (OS) is installed on your local PC:

- Windows 7, 8, or 10
- Apple Mac OS X 10.10 or higher
- Linux distribution

Note

For more information about supported Linux distributions in SAP environments, click here: http://scn.sap.com/docs/DOC-8760

Java Runtime Environment (JRE)

Java Runtime Environment (JRE) 1.8 32-Bit (for the 32-bit version of ABAP Development Tools) or 64-Bit (for the 64-bit version of ABAP Development Tools) is installed on your local drive.
If this is not the case, install, for example, the latest version of the SAP Java Virtual Machine from the SAP Software Download Center on the SAP Service Marketplace (http://service.sap.com/swdc).

**Note**
The Java Development Kit (JDK) is also convenient because it includes JRE.

### Eclipse

You have already installed a suitable Eclipse installation package Eclipse 4.5 Release (Mars) or 4.6 Release (Neon).

**Note**
Technically any Eclipse package with feature `org.eclipse.platform` of the corresponding release is installed, as a minimum, on your local drive.

### SAP Software and SMP Access

- For Windows OS, SAP GUI for Windows 7.40, is installed on your local drive. For Apple Mac or Linux OS, SAP GUI for Java 7.40, is installed on your local drive.

  **Note**
  If this is not the case, install the SAP GUI first from the SAP Software Download Center on the SAP Service Marketplace.
  You will need this SAP GUI for integration of GUI-based tools in the new ABAP IDE.

- You have an **S User** that enables to download the ABAP Development Tools package from the SAP Service Marketplace (SMP).

### Internet Browser

On your local drive, one of the following browsers is installed:

- **Internet Explorer** 7.0 or higher
- **Firefox** 4.0 or higher

### Microsoft Components

**Microsoft Runtime DLLs VS2010** (for Windows OS) is installed on your local drive. You need this component for communication with the backend system.
3.1.2 Context

The ABAP Development Tools are installed from the SAP Software Download Center on the SAP Service Marketplace. From here, you download the archive file with the corresponding IDE components onto your local drive.

3.1.2.1 Use Cases

Subsequent installation of the SAP components requires you to already have a suitable Eclipse installation operating on your computer.

Which Eclipse version is suitable depends among other things on the use cases that you implement the Eclipse platform or Eclipse IDE for. To use in a combination with BW Modeling Tools, you have the following two options:

- **ABAP development on SAP HANA:** For this use case, you need to have SAP HANA Studio 2.0 (revision 112 or higher) installed on your local drive. This is the recommended approach. It will be described in detail in the following steps.
- **Side-by-side Java and ABAP development:** For this use case, you usually need to have an Eclipse edition running as your development environment. You can add ABAP Development Tools to your existing Eclipse installation.

3.1.3 Installation Steps

**Procedure**

1. Download the ABAP Development Tools package from the SAP Service Marketplace ([support.sap.com/swdc](http://support.sap.com/swdc)):
   a. Launch the SAP Software Download Center
   b. In the **Support Packages and Patches** section, open the **Search for Support Packages and Patches** subsection.
c. In the **Search Term** input field, enter **ABAP in ECLIPSE** for the name of the installation package.

   ![Note]
   
   *Note*
   
   In the **Search Method** list box, select the **Phrase** item in order to run the search faster.

   Select in the appearing Web page the latest 2.x release.

d. In the **Search Results** view, choose the **ADT 2.60** or newer package.
e. Add the package to the download basket.
f. Download the archive zip file to the local directory of your choice.

2. Install additional Eclipse features that are required for running ABAP Development Tools:

a. Launch the Eclipse platform or SAP HANA Studio (see prerequisites above) that is installed on your local drive on the SAP Service Marketplace.
b. Choose **Help > Install New Software…** to start the installation wizard.
c. In the **Work with** on the SAP Service field in the wizard, specify the update site that you downloaded the Eclipse installation package from.
d. To simplify the selection, uncheck the **Group items by category** field on the wizard page.

![Figure 1: Installation package for Eclipse 4.5 (Mars) that is installed on the local machine]
e. Select the following Eclipse features from the table below – depending on whether or not you are going to install ABAP Development Tools on top of SAP HANA Studio.

**Note**

1) This Eclipse feature is already part of the "Eclipse IDE for Java Developers" installation package.
2) This Eclipse feature is required only if you intend to install the “ABAP Connectivity and Integration Development Tools”.

If installing to a SAP HANA Studio:

Table 6: List of additional features required for running ABAP Development Tools for SAP NetWeaver

<table>
<thead>
<tr>
<th>Feature Name</th>
<th>Feature ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMF Model Query</td>
<td>org.eclipse.emf.query</td>
</tr>
<tr>
<td>Mylyn Commons</td>
<td>org.eclipse.mylyn.commons</td>
</tr>
<tr>
<td>Mylyn Task-Focused Interface</td>
<td>org.eclipse.mylyn.context_feature</td>
</tr>
</tbody>
</table>

f. Once you have finished making your selections, insure that the filter box is empty and then choose Next.

g. On the next wizard page, review the list of features to be installed and choose Next.

h. Once you have accepted the terms of license agreement, initiate the installation of the selected features by pressing Finish.

i. To apply the changes, restart the Eclipse workbench using the corresponding button in the information dialog that appears.

3. Installing the ABAP Development Tools package:

a. Launch the installation wizard again by choosing Help > Install New Software…

b. In the Work with field in the wizard, now specify the target directory where you downloaded the package using ABAP Development Tools.

**Tip**

To add the new installation directory, click the Add... > Archive... button to specify the location, and enter a name for your local software site. As highlighted in the screenshot below, make sure that the location path starts with “jar:file:”. 
c. To simplify the selection, check the **Group items by category** field on the **Wizard** page.

d. Select all **ABAP Development Tools for SAP NetWeaver** items and choose **Next**.

![Image of software installation interface](image)

**Note**

ABAP Core Development tool is a mandatory installation, whereas installation of other tools is optional. Select optional tools according to your particular requirements.

![Image of software installation interface](image)

**Figure 3: The target directory where you extracted the zip file to in step 1 d) serves as the local software site for installation of ABAP Development Tools.**

e. On the next page, review the feature groups to be installed and choose **Next** again.
During the course of fetching content for installation, you will receive a warning that unsigned software content is being installed. Press **OK** to continue with the wizard.

Once you have accepted the terms of the license agreement, initiate the installation of the selected SAP feature groups by pressing **Finish**.

In the **Certificates** dialog box, confirm the certificates from Eclipse.org and SAP by pressing **OK**.

To apply the changes made during the installation process, restart the Eclipse workbench.
3.1.4 Result

The successful installation procedure provides you (as a system administrator at SAP customer side) with a ready-to-use ABAP IDE. It contributes the ABAP perspective to the Eclipse workbench.

The Welcome page (Help > Welcome) provides central access to knowledge material and provides links to related ABAP Development User Guide topics.

![ABAP Welcome Page](image)

Figure 6: The Quick Launch on the Overview tab provides you with compact knowledge that you may need when working with the new ABAP IDE for the first time.

3.2 Installing BW Modeling Tools

The steps to install the BW Modeling Tools are identical to the steps for ABAP Development Tools. Only the installation (repository) folder used and the required features are different.

Procedure

1. Choose Help > Install New Software... to restart the installation wizard.
2. Select **Add…** and enter the location of the BW Modeling Tools setup files.

![Add Repository](image)

3. In the **Work with** field in the wizard, specify the update site that you downloaded the installation package from.

4. Select the suitable features from the installation package.

   You can install both BW Workbench and BW Query Designer, or each feature group separately. If you like to only use the BW Query Designer, we recommend to install it on Eclipse. The following table shows the supported installation options in detail:

<table>
<thead>
<tr>
<th>Installation option</th>
<th>Integration</th>
<th>BW Workbench</th>
<th>BW Query Designer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Eclipse</td>
<td></td>
<td>x</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td></td>
<td></td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>SAP HANA Studio</td>
<td></td>
<td>x</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>x</td>
</tr>
</tbody>
</table>

Table 7: Installation options
Table 8: Items that you want to install

<table>
<thead>
<tr>
<th>Name</th>
<th>ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>BPC Embedded Planning</td>
<td>com.sap.bw.feature.bpcplanning.group</td>
</tr>
<tr>
<td>BW Modeling Tools Integration with SAP HANA Studio</td>
<td>com.sap.bw.feature.hana.feature.group</td>
</tr>
<tr>
<td>BW Workbench</td>
<td>com.sap.bw.feature.workbench.feature.group</td>
</tr>
<tr>
<td>BW Query Designer</td>
<td>com.sap.bw.feature.query.feature.group</td>
</tr>
</tbody>
</table>

5. When you have made all required entries, choose **Next**.
6. On the next wizard page, review the list of features to be installed and choose **Next**.
7. Once you have accepted the terms of license agreement, initiate the installation of the selected features by choosing Finish.

8. To apply the changes, restart the SAP HANA Studio by choosing the restart button in the information dialog box.

**Results**

Once installation is complete, BW administrators are equipped with a ready-to-use BW modeling IDE. This adds the BW modeling perspective to the SAP HANA Studio.

Initially, you will probably see the SAP HANA Studio Welcome screen. To enter the BW Modeling perspective, close the Welcome screen and choose Window > Open Perspective > Other… A dialog box appears. Choose BW Modeling and confirm by pressing the OK button.
You have now opened the perspective that allows you to create new BW projects.

### 3.3 Updating BW Modeling Tools

To install the BW Modeling Tools for the first time, or to update them, use the SAP Software Download Center on the SAP Service Marketplace.

#### Context

On the SAP Service Marketplace, you will always find the most current version as an archive file with the corresponding IDE components.

#### Note

Note that SAP does not follow the standard Eclipse update procedure. SAP provides a new installation of BW Modeling Tools instead of an update procedure.
Note

Make sure that you always only install suitable versions of SAP HANA Studio, ABAP Development Tools and BW Modeling Tools. There is no guarantee that all possible combinations of releases on the SAP MarketPlace will work. Check SAP Note 1905207 for supported releases.

Procedure

1. Download the new version of the BW Modeling Tools package from the SAP Service Marketplace.
2. Install the new BW Modeling Tools package as described in the installation procedure.

3.4 Recommendations for the System Administrator

To make the installation of the BW Modeling Tools available in your organization to BW model developers, we recommend that you (the system administrator) perform the following steps:

- Make the downloaded ZIP file for the BW Modeling Tools package available on a file share. Each BW model developer performs steps 2 and 3 of the installation description on his or her local drive.
- Build a separate update site that contains the required Eclipse and the SAP feature groups. These updates are available to all BW model developers concerned – either through a Web server or a file share – for internal use. This option has the advantage that you can use the standard Eclipse update mechanism in full within your organization. Use the “Eclipse P2 Publisher” tool provided by Eclipse to build your combined update site.
4 Post-Installation

4.1 Configuring Eclipse Runtime Options

In order to avoid out-of-memory errors while running BW Modeling Tools, you have to make sure that there is sufficient memory on the heap.

Context

To achieve this, you can make the Java Virtual Machine (VM) increase the total amount of memory. This is done by adding VM arguments to configure the JAVA VM used to run SAP HANA Studio. The following configuration recommendations should work for most installations.

Note
It is generally advisable to prepare one configuration and then distribute it to the corresponding BW modelers.

Procedure

1. In the SAP HANA Studio installation folder, open the `hdbstudio.ini` file.
2. Add the following two lines with Java VM arguments after the `-vmargs` command line:
   
   ```
   -XX:PermSize=32m
   -XX:MaxPermSize=512m
   ```

3. We also recommend adding the following Java VM start-up options too:
   
   ○ Set default encoding of Java VM
   ○ Set user language to EN
   ○ Set a heap dump if you encounter an out-of-memory error
   ○ Set the minimum Java version required to launch Eclipse

   ```
   -Dfile.encoding=UTF-8
   -Duser.language=EN
   ```
-XX:+HeapDumpOnOutOfMemoryError
-Dosgi.requiredJavaVersion=1.7
5 Additional Information

The following sections provide important additional information.

Related Information

- Getting Support Information [page 29]
- Uninstalling BW Development Tools [page 26]

5.1 Uninstalling BW Development Tools

Context

To uninstall all front-end components required to run BW Modeling Tools, proceed as follows:

Procedure

1. Launch your BW Modeling Tools installation environment (if it is not already running).
2. Choose Help > About….
3. Press the Installation Details button.
4. Select the nodes of the BW features.
5. Press the Uninstall... button.
The Uninstall Details page displays a list of feature groups that will be uninstalled.

6. To start uninstalling, choose Finish.

5.2 Updating BW Modeling Tools

Context

If you want to update an existing version of BW Modeling Tools, open the SAP Software Download Center on the SAP Service Marketplace. Here, you will always find the most current version as an archive file with the corresponding IDE components.

Note

If you want to update the SAP HANA Studio installation, we always recommend uninstalling the BW Modeling Tools first. Due to the fact that there can be direct dependencies between the SAP HANA Studio revision used and the version of BW Modeling Tools, this step is strongly recommended. You should also keep in mind that uninstalling components in Eclipse only removes the feature registration. The actual plug-in files will be
retained, meaning that the SAP HANA Studio folder will become larger. We therefore recommend to always perform a new installation rather than to perform updates.

Procedure

1. Download the new version of the BW Modeling Tools package from the SAP Service Marketplace to your local installation directory.
   - If the downloaded archive has the same name as the former archive, you can add the major and minor version to the name of the downloaded archive. You therefore do not need to replace the former archive. This enables you to revert the update if required.

2. Configure the new archive as an update site.
   a. In the menu bar, choose \**Windows > Preferences**.
   b. In the Preferences window, choose \**Install/Update > Available Software Sites**.
   c. To add the new archive, choose \**Add... > Archive...** in order to specify the location, and enter a name for your local software site: `jar:file:/<drive:>/<directory_with_zipped_content>`

3. Trigger the update by choosing \**Help > Check for Updates**.

**i Note**

For compatibility reasons, the local cache (semantic file cache), which is assigned to a BW project, will be automatically deleted. If any editors are open that access BW models in the same project, these are closed automatically.

If you have problems, you can manually delete the local cache proceeding the following steps:

1. From the Workbench menu, choose \**Window > Show View > Other**.
2. You are now in the \**Show View** selection dialog. Enter \**semantic** in the filter line. The preselection should now contain just one entry: "Semantic Content". Select this entry.
3. The system should now display the semantic content view with all available BW projects. Go to this view and expand the project tree under the relevant project. Choose the \*.bw folder and open the context menu.
4. In the context menu, choose \**Forceful Delete of Corrupted Content** and choose \**OK** to confirm the dialog box that appears.

The following image shows the context menu on a bw folder.
Next Steps

Please bear in mind that it might also be necessary to update further components, such as ABAP Development Tools. For further details, see the corresponding release information note.

5.3 Getting Support Information

If errors occur in connection with BW Modeling Tools, SAP customers might need more detailed support from SAP.

Context

If errors occur, it is very important that you, the SAP customer, provide all the required data, in order to speed up the troubleshooting process. To help you do this, BW Development Tools provides a convenient support tool. With a few simple mouse clicks, you can generate a support information file. This file contains all the relevant data for your IDE or GUI version, as well as information on preference settings and technical system environment data. You can then add this support file to your OSS problem message as an attachment.

To collect the support information, proceed as follows:

Procedure

1. In your BW Modeling Tools environment, choose Help Collect Support Information.
2. A dialog box appears. Specify the location of the support file and choose Finish.
6 Support and Maintenance Strategy

The Modeling Tools for SAP BW powered by SAP HANA include a server part and a client part. In both cases, the Support and Maintenance Strategy is different from SAP NetWeaver 7.4 SP5.

6.1 Server

As SAP GUI or ABAP Development Tools the Modeling Tools for SAP BW powered by SAP HANA (also referred to as BW Modeling Tools) follow the SAP Maintenance Strategy Rule 11: Downward-compatible software component versions can be replaced by a higher version during the lifetime of the application release into which they are built, without adaptations or changes to other software component versions in the release. Therefore downward compatible software component versions are usually not maintained for the entire mainstream and extended maintenance period of the application release into which they are built. Instead these versions have to be replaced by a higher version.

Modeling Tools for SAP BW powered by SAP HANA is a downward-compatible software component version. This means that starting with SAP NetWeaver 7.4 SP05, the most current client version of the BW Modeling Tools will always be compatible with all future SAP NetWeaver 7.4 Service Packs. This requires users to regularly update to the most up-to-date client version. Since the client has many dependencies, this may require additional updates on the PC. These additional updates are listed in the client section.

6.2 Client

General Terms

The Modeling Tools for SAP BW4HANA and SAP BW powered by SAP HANA (also referred to as BW Modeling Tools) depend on SAP GUI and can be installed on SAP HANA Studio. Both SAP HANA Studio and SAP GUI are supported on different platforms. Support for individual platforms also depends on whether operating systems are still supported by the manufacturers. SAP cannot provide support for a platform or operating system that no longer is supported by its vendor or manufacturer.

Support Platform Matrix

BW Modeling Tools are only supported on a subset of the individual platform and operating system versions that are suitable for use with SAP HANA Studio and SAP GUI. The list of different operating system versions, Java Runtime versions, SAP HANA Studio versions, SAP GUI versions, Microsoft VC Runtime versions and Browser
versions, which are supported by the BW Modeling Tools, can be found in the BW Modeling Tools Support Platform Matrix (SPM). Any operating system versions, Java Runtime versions, Eclipse versions, SAP GUI versions, Microsoft VC Runtime versions and Browser versions, which are not listed in the BW Modeling Tools SPM, are not supported by SAP.

Table 9: SPM

<table>
<thead>
<tr>
<th>Platform or Component</th>
<th>Supported Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating System</td>
<td>Windows 7, Windows 8, Windows 10, Apple Mac OS X 10.8 or higher, Linux distribution supported in SAP environments</td>
</tr>
<tr>
<td>Java Runtime</td>
<td>JRE 1.8 or higher, 32 bit or 64 bit</td>
</tr>
<tr>
<td>MS VC Runtime</td>
<td>Version 10, 32 bit or 64 bit (Windows OS)</td>
</tr>
<tr>
<td>SAP GUI for Windows</td>
<td>7.4 (Windows OS)</td>
</tr>
<tr>
<td>SAP HANA Studio</td>
<td>SP 11 or higher</td>
</tr>
<tr>
<td>Browser</td>
<td>Internet Explorer 7.0 or higher, Firefox 4.0 or higher</td>
</tr>
</tbody>
</table>

**Special Terms for Operating Systems**

SAP recommends that you always use an up-to-date Support Package for the relevant operating system listed on the BW Modeling Tools SPM. Operating systems that are no longer supported by the operating system manufacturer, should not be used in conjunction with BW Modeling Tools. If an issue occurs on an unsupported operating system, SAP will not analyze or attempt to solve the issue. You will receive a reply that recommends an operating system upgrade. In addition, SAP no longer tests BW Modeling Tools on these operating systems.

**Special Terms for Java Runtime Versions**

SAP recommends that you always use an up-to-date Java Runtime version listed on the BW Modeling Tools SPM. Java Runtime versions that are not supported by the Java Runtime version manufacturer, should not be used in conjunction with BW Modeling Tools. If an issue occurs on an unsupported Java Runtime version, SAP will not analyze or attempt to solve the issue. You will receive a reply that recommends a Java Runtime version upgrade. In addition, SAP no longer tests BW Modeling tools on these Java Runtime versions.

**Special Terms for Microsoft VC Runtime Versions**

SAP recommends that you always use an up-to-date Microsoft VC Runtime version listed on the BW Modeling Tools SPM. Microsoft VC Runtime versions that are no longer supported by Microsoft, should not be used in conjunction with BW Modeling Tools. If an issue occurs on an unsupported Microsoft VC Runtime version, SAP will not analyze or attempt to solve the issue. You will receive a reply that recommends a Microsoft VC Runtime version upgrade. In addition, SAP no longer tests BW Modeling Tools on these Microsoft VC Runtime versions.
Special Terms for SAP HANA Studio

SAP recommends that you always use an up-to-date SAP HANA Studio version listed on the BW Modeling Tools SPM. SAP HANA Studio versions that are no longer supported by SAP, should not be used in conjunction with BW Modeling Tools. If an issue occurs on an unsupported SAP HANA Studio version, SAP will not analyze or attempt to solve the issue. You will receive a reply that recommends a SAP HANA Studio version upgrade. In addition, SAP no longer tests BW Modeling Tools on these SAP HANA Studio versions.

Special Terms for SAP ABAP Development Tools

SAP recommends that you always use an up-to-date SAP ABAP Development Tools version listed on the BW Modeling Tools SPM. SAP ABAP Development Tools versions that are no longer supported by SAP, should not be used in conjunction with BW Modeling Tools. If an issue occurs on an unsupported SAP ABAP Development Tools version, SAP will not analyze or attempt to solve the issue. You will receive a reply, which recommends an SAP ABAP Development Tools version upgrade. In addition, SAP no longer tests BW Modeling Tools on these ABAP Development Tools versions.

Special Terms for SAP GUI Versions

SAP recommends that you always use an up-to-date SAP GUI version listed on the BW Modeling Tools SPM. SAP GUI versions, which are no longer supported by SAP, should not be used in conjunction with BW Modeling Tools. If an issue occurs on an unsupported SAP GUI version, SAP will not analyze or attempt to solve the issue. You will receive a reply that recommends an SAP GUI version upgrade. In addition, SAP no longer tests BW Modeling Tools on these SAP GUI versions.

Special Terms for Browser Versions

SAP recommends that you always use an up-to-date browser version listed on the BW Modeling Tools SPM. Browser versions that are no longer supported by the browser manufacturer, should not be used in conjunction with BW Modeling Tools. If an issue occurs on an unsupported Browser version, SAP will not analyze or attempt to solve the issue. You will receive a reply that recommends a Browser version upgrade. In addition, SAP no longer tests BW Modeling Tools on these Browser versions.

Language Support

SAP does not explicitly release any language versions of BW Modeling Tools other than English.
SAP Shipment Channel and License Agreement

The use of BW Modeling Tools is subject to the terms and conditions of your license agreement with SAP, which is directly related to the SAP shipment channel from which BW Modeling Tools were initially downloaded and installed. SAP does not support updating BW Modeling Tools using software from any SAP shipment channels, other than the channel used for the initial installation of BW Modeling Tools.
Important Disclaimers and Legal Information

Coding Samples

Any software coding and/or code lines / strings ("Code") included in this documentation are only examples and are not intended to be used in a productive system environment. The Code is only intended to better explain and visualize the syntax and phrasing rules of certain coding. SAP does not warrant the correctness and completeness of the Code given herein, and SAP shall not be liable for errors or damages caused by the usage of the Code, unless damages were caused by SAP intentionally or by SAP’s gross negligence.

Accessibility

The information contained in the SAP documentation represents SAP’s current view of accessibility criteria as of the date of publication; it is in no way intended to be a binding guideline on how to ensure accessibility of software products. SAP in particular disclaims any liability in relation to this document. This disclaimer, however, does not apply in cases of willful misconduct or gross negligence of SAP. Furthermore, this document does not result in any direct or indirect contractual obligations of SAP.

Gender-Neutral Language

As far as possible, SAP documentation is gender neutral. Depending on the context, the reader is addressed directly with “you”, or a gender-neutral noun (such as “sales person” or “working days”) is used. If when referring to members of both sexes, however, the third-person singular cannot be avoided or a gender-neutral noun does not exist, SAP reserves the right to use the masculine form of the noun and pronoun. This is to ensure that the documentation remains comprehensible.

Internet Hyperlinks

The SAP documentation may contain hyperlinks to the Internet. These hyperlinks are intended to serve as a hint about where to find related information. SAP does not warrant the availability and correctness of this related information or the ability of this information to serve a particular purpose. SAP shall not be liable for any damages caused by the use of related information unless damages have been caused by SAP’s gross negligence or willful misconduct. All links are categorized for transparency (see: http://help.sap.com/disclaimer).